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Exercise 4: Digitizing New Data 

In this exercise, you will learn the process of creating and editing spatial 
datasets using on-screen, or heads up, digitizing. This is one of the many 
methods of data creation used in GIS. We will also introduce you to how to 
connect to a GIS server.   

 

Topics covered in this exercise include: 

1. Create a new shapefile in ArcCatalog 
2. Add fields to a new shapefile 
3. Edit spatial data using the editing function in ArcGIS Pro 
4. Connect to a GIS server 

 

Step 1. Preparing to Draw 

In contrast to the previous exercises, you will not be provided with a map 
project file. Instead, you will create a new project from scratch. This is a 
common first step when starting a new study and GIS project. You can use 
this method to create your own projects using your own data.  

� Open ArcGIS Pro. This can be done by navigating to All Apps followed 
by the ArcGIS Folder. Within the ArcGIS folder, select ArcGIS Pro. 
Note that you can also use a Task Bar or Desktop shortcut if they are 
available on your machine.  

� Once ArcGIS Pro launches, select Blank 
under Create a new project on the right side 
of the page.  

� In the Create a New Project Dialog Box, 
name your new project Exercise_4 and 
save it to your personal Exercise_4 folder. 
You can leave “Create a new folder for this 
project” option selected.  

� Click OK to create the new project.  
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Create a new map.  

� Under the Inset Tab select New Map. This will load a new map called 
Map with a topographic base map.  

� Now, rename the map. Double-click on Map in the Contents 
Pane. This will open the Map Properties Window. In this 
window, change the name under the General Tab to 
Olympic Park. 

� Click OK to accept the change.  

 

You will now add a reference image to the map. This image was taken from 
an aerial view of the Olympic Park from the Tokyo Olympic games in 
summer 2020.  

Download the Exercise_4 data from https://www.wvview.org/. All lab 
materials are available on the course webpage and linked to the exercise. 
You will need to extract the compressed files and save it to the location of 
your choosing.  

� In ArcGIS Pro - Click on the Add Data Button. Navigate to your copy of 
the lab data. Navigate to Exercise_4 folder. Select the 
olympic_park.png file. This image is created from a google maps 
aerial view of the area. Click OK to add it to the map. 

� You can turn off the World Topographic base map if you’d like. You 
don’t need it.   

In this exercise we will have you create a new shapefile and digitize new 
features into the file. Note that you could also use a feature class within a 
geodatabase. However, this will be demonstrated in a later lab. So, here we 
will have you work with a shapefile, which is a standalone file used to store 
vector data outside of a geodatabase. There are different ways to create a 
new shapefile. Here, we will use the Create Feature Class tool, which can 
be used to make shapefiles and feature classes.   

https://www.wvview.org/
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� In the Analysis Tab select the Tools icon. This will launch the 
Geoprocessing Pane.  

� Search for the Create Feature Class tool.  
� In the tool, name the new layer olympic_park_draw.shp, 

save it to a folder of your choosing, define the Geometry Type as 
“Polygon” and set the Coordinate System to “Current Map”. Run the 
tool to create the new file. The new file should add to the list of layers 
in the Content Pane. 

In this exercise, you will oversee digitizing some of the major athletic 
buildings and tourist areas nearby to help tourists navigate the area. 
However, there are still a few more steps before you can begin. First, we 
would like you to store the name of the building in the attribute table. So, 
you need to add a field.  

� Right-click on the olympic_park_draw layer in the Contents 
Pane then select Attribute Table. The attribute table should 
load. Note that “FID,” “Shape,” and “Id” fields are already 
included in the table. You would like to add a new field called “name.” 

� Click the Add button at the top of the table.  
� A new table should load called Fields: olympic_park_draw. At the 

bottom of the list of fields, you can add new fields. In the Field Name 
column type “name” (without the quotes) and set the Data Type 
to Text (this is because you will type a text string in this field). 
You do not need to specify an Alias. Click Save at the top of the 
screen to create the field.  

 

� Return to the olympic_park_draw attribute table. You should now see 
the new “name” column.  

� To free up space, exit out of the tables.  

Here, you will draw polygon features. I have generally found that these are 
easier to draw if they are symbolized using no fill and only an outline. So, we 
will have you change the symbology of the layer.  

� Right-click on the olympic_park_draw layer and select Symbology. 
� Click on the symbol in the Symbology Pane.  
� Switch to Properties as opposed to Gallery. 
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� Change the Color to No Color. 
� Change the Outline Color to something easy to see, like red. You may 

also want to increase the Outline width. We used 1 pt.  
� Click Apply to accept the changes.  

 

� You may want to exit out of the Symbology Pane to save space.  

Step 2. Drawing 

You are now ready to start drawing and editing the attribute table.  

� Navigate to the Edit Tab. 
� Turn on the Attribute Pane by clicking on this option. 

We will begin by drawing in the National Stadium.  

� Zoom in so that the National Stadium fills a large portion of the map 
space. The larger the object of interest is on the screen, the easier it 
will be to trace it.  
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� Click on the Create button. This will load the Create Features 
Pane. You are now ready to start drawing. Click on the layer 
in the Create Features Pane in which you want to draw a new 
feature. In this case, you only have the one layer available, 
olympic_park_draw; however, if more vector layers were included in 
the layout then you would need to choose which to draw into. Click on 
olympic_park_draw to draw into it. You are now ready to draw. 

� Since this is a building, and we would expect to have right angles on 
each corner, I would suggest using the right-angle drawing tool. Feel 
free to experiment with the different drawing tools. 

 

 

If you hover over the different drawing tools, a brief explanation will be 
provided. I chose to use the first option because the stadium is round.  

� Once you’ve selected a drawing tool, move to the map space and click 
once at the location on the map where you want to add a vertex. 
Continue clicking to add additional vertices. Work your way around the 
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object, just like you were walking the perimeter. When you get to the 
last vertex, double-click. This will close the feature and create a new 
polygon object. Note that your drawing doesn’t have to be perfect.  

Note: If you would like to erase your last vertex, use CTRL+Z. Once you’ve 
completed an object and it is still selected, you can remove or delete the 
object by using CTRL+Z.  

Here is an example of my result.  

  

 

There are many tools available to clean up or improve your drawing. I would 
encourage you to experiment with the tools available in the tools list. 
Hovering over a tool will provide a brief explanation.  

 

If you are not happy with the quality of your drawing, you can always delete 
it and try again. Note that there are tools available to move the whole 
feature, add vertices, remove vertices, edit vertices, reshape features, split 
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single features into multiple features, merge multiple features into a single 
feature, modify features, and delete features.  

The Snapping options allow you to enforce snapping. For example, if you 
were drawing line features and you wanted them to connect, such as rivers 
or roads, you could use snapping to enforce this.  

When you are drawing, it is also important that you save often so as not to 
lose your work. Let’s save your work. 

� Click the Save button under the Manage Edits area in the Edit Tab.  

Again, save often so as not to lose any work. 

 Now, we would like you to name the 
building in the attribute table.  

� Navigate to the Attributes 
Tab. Since you were just using 
the Create Features Pane, the 
Attribute Pane is now probably 
behind it, but there should be 
a tab at the bottom of the 
screen. If you can’t find it, 
click on the Attributes button 
again in the Selection area of 
the Edit Tab. 

� Make sure that the capital 
building polygon is selected.  

� In the Attributes Tab, type in 
“National Stadium” (without 
the quotes) in the “name” 
field.  

� Save your work again.  

You have now successfully created a 
new polygon and edited the 
associated attributes. 

Deliverable 1 (30 Points) 

Draw polygons for the following buildings:  

National Stadium, Tokyo Gymnasium, Meiji Memorial Picture Gallery, Meiji 
Jingu Stadium, Chichibunomiya Rugby Stadium, Meiji Shrine Garden (the 
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entire lower half of the oval), Tokyo Indoor Pool, and the Tokyo Gym athletic 
field.  

You can use the images below to locate these buildings or search for them in 
google maps. 

  

Provide the name of each building in the attribute column “name” field. 
Again, remember to save your edits and project often. These are two 
separate processes. 

Note: Throughout this process, you will need to switch between drawing and 
navigating the map space. The navigation tools are available under the Map 
Tab while the drawing tools are available under the Edit Tab. You will need 
to switch back and forth. If you need to select a feature, the Selection Tool 
is available in the Map Tab and in the Editing Tab. Remember that the 
attributes displayed in the Attribute Pane are for the selected feature. If you 
want to view the layer attribute table at any time, you can do so by opening 
the attribute table. This is a good way to check your edits.  

Drawing in ArcGIS Pro, especially for a beginner, can be frustrating. Take 
your time and don’t hesitate to ask if you have any questions.  

You will be asked to symbolize each building or area in a different color, 
remember you can set your symbology to unique values based on name. 
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Make a map layout that includes the following: 

1. All your buildings are displayed using a different color (4 points) 
2. The names of the buildings are in the legend (4 points) 
3. The image data are not included in the legend (2 points) 
4. A scale bar in kilometers (3 points) 
5. A north arrow. The north arrow should not be large or take up a lot 

of space on the layout (3 points) 
6. A descriptive title (3 points) 
7. Your name (2 points) 
8. In portrait orientation (3 points) 
9. The map is overall very neat and well organized. Spaced is utilized 

well, and the data are well presented (6 Points) 

Provide an output of your map as a PDF and turn it in as part of the 
lab submission.  

Here are some hints. 

1. You will need to add a new layout to the project.  
2. To symbolize the buildings using a different color for each building, 

you will need to use a Unique Values method and the “name” field. 
3. Referring back to the last lab may help with map design. 
4. Don’t hesitate to ask if you have any questions.  

Step 3. Connecting to a GIS Server in ArcGIS Pro  

Other than using data from your local machine or network, it is possible to 
stream data from a server. Here, we will show you how to connect to a GIS 
server. Specifically, we will connect to the USGS National Map server. 

� In ArcGIS Pro, navigate to the Insert Tab.  
� Within the Project area, click on the dropdown arrow associated with 

Connections. Select New GIS Server.  
� As the Server URL provide the following address: 

https://basemap.nationalmap.gov/arcgis/rest/services/USGSTopo/Map
Server.  

� This website does not require a Username or Password as it is open to 
the public.  

https://basemap.nationalmap.gov/arcgis/rest/services/USGSTopo/MapServer
https://basemap.nationalmap.gov/arcgis/rest/services/USGSTopo/MapServer
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� You first need to add a new map to the 
project to add the data to. 

� To add data, click on the Add Data button in 
the Map Tab and then the top option that says 
Data. 

� Once you select Data, a new window will 
open. Select ‘Servers’ under projects then 
select this server from the list. This will load 
the list of available layers.  

Look for the USGSHydroCached layer. This will add 
a layer of hydrologic data to the map. This can be a 
reference source for digitizing. Feel free to 
experiment with the available maps. 

Step 4. Digitizing Server Data 

In this section, you will take the USGS hydrologic 
data you added in the last step and do another 
round of digitizing. Using server data can help you 
create data for specific features. 

If you added other service data from USGS, remove them so that you only 
have the USGSHydro map.  

In the map tab, click the Locate button, this will open the locate pane on the 
right side of the screen. In the search bar, type ‘Stonewall Jackson Lake 
State Park’. This will bring you to zoomed in area on the map. To see the 
lake, zoom out until your scale is around 1:120,000 and center your map so 
you can see the lake and the Stonecoal Reservoir. Your map should look like 
this: 
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Your next task is to follow the previous steps to digitize the lake in the park 
and the Stonecoal Reservoir. This is a very detailed hydrologic map, so don’t 
worry about getting every detail, just do your best to get the general shape 
of both bodies of water. Ignore the rivers, just focus on the main bodies of 
water. 

Deliverable 2 (30 Points)  

Make a map layout to include the following:  

1. Both water bodies are displayed with a different color (3 points)  
2. The names of the water bodies are in the legend with a different color 

symbolized for each (3 points) 
3. The USGS layer name is not included in the legend (2 points)  
4. A scale bar in miles (3 points)  
5. A north arrow. The north arrow should not be large or take up a lot of 

space on the layout (3 points)  
6. A descriptive title (3 points)  
7. Your name (2 points) 
8. In landscape orientation (3 points) 
9. A reference is provided for your base map (should read: “Base 

imagery from ArcGIS base map data.”) (4 points)  
10. The map is overall very neat and well organized. Spaced is utilized 

well, and the data are well presented (4 Points)  

Here are some hints.  

1. You will need to add a new layout to the project.   
2. You will need to create a new feature class, and make sure it has the 

same coordinate system as the current map. 
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3. You will need to add a name field in the attribute table. 
4. To symbolize the lakes using a different color for each lake, you will 

need to use a Unique Values method and the “Name” field. You will 
need to expand the lakes layer in the Contents Pane and make  
these changes on the Polygons sublayer.   

5. Referring back to the last lab may help with map design 
6. Don’t hesitate to ask if you have any questions.   

 

This lab will be graded out of 60 points. Make sure to deliver both 
maps to your instructor as PDF files. 

 

END OF EXERCISE 


